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Heritage Craft – Bible Scan Projects 
Mary Kircher Roddy – www.mkrgenealogy.com 

 

Supplies for project: 

Bible, book, letters (or whatever) to scan 

Card stock 

String, yarn, or embroidery floss 

Scissors or cutting tool 

Ribbon 

 

Tools for Project: 

Computer with software to manipulate scans (eg 

Microsoft Publisher) 

Printer 

Scissors 

Hole punch for Pyramid box 

 

General Instructions: 

Scan several pages of bible or book 

 

Import a scanned image into software such as 

Microsoft Publisher. (Insert  Picture)  Crop a 

section of the image (Format Crop.  Bars will 

appear at the center of each side of the image.  

Hold the left mouse button down and drag the 

side(s) inward to create a square or rectangle 

approximately 2-3” x 2-4”), then Rotate it 

(Format Rotate  Free Rotate – A circle with 

an arrow will appear when you hover over any 

of the corners of your image  Hold the left 

mouse button down and drag the corner to rotate 

the image.)  Import another image, crop and 

rotate. Repeat until you have an 8 ½ x 11 

“collage.”  It’s OK if parts of the image extend 

beyond the 8 ½ x 11 area.  The effect you are 

striving for is that you cut up a book and glued 

the pages randomly onto a background. 

 

If you want a double-sided paper, you can create 

a different collage or use the same one and print 

on both sides. 

 

Print your collage on cardstock on one side or 

both sides depending on the project. 

 

Project 1: Angel Wings 

Create a pattern for angel wings – Fold an 8 ½ x 

11 paper in half and sketch out a wing pattern.  

Cut it out and open up the fold.  Play with 

cutting and sketching until you are satisfied with 

the look of the wing pattern. 

Print your collage on both sides of a piece of 

cardstock. 

Trace wing pattern on cardstock and cut out. 

Wrap string around center section of wings 

about 10 times.  Make hanger out of string. 

 

 
Photo by Emmeline Roddy 

 

Project 2: Pyramid box 

Print collage onto one side of card stock 

Print pyramid box pattern onto blank side of 

card stock.  Pattern can be found at: 
http://sassafras.typepad.com/files/boxtemplate.pdf 
Cut out box pattern on outer line.  Instructions 

for folding can be found at: 

http://www.linesacross.com/2012/05/paper-

pyramid-gift-boxes.html 

 

Punch holes, at top of flaps.  Thread ribbon 

through holes, insert small gift and tie ribbon 

into bow. 

 

http://sassafras.typepad.com/files/boxtemplate.pdf
http://www.linesacross.com/2012/05/paper-pyramid-gift-boxes.html
http://www.linesacross.com/2012/05/paper-pyramid-gift-boxes.html
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Makes a charming box for jewelry or a 

chocolate truffle. 

 

 
Photo by Emmeline Roddy 

Attached below is the collage from my great-

grandmother’s 1870 German bible.  Feel free to 

use it if you don’t want to make your own. 
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Heritage Craft – Photo Rock Paperweight 
Mary Kircher Roddy – www.mkrgenealogy.com 

 

 

Photo by Mark Roddy 

 

Supplies for project:  
Light colored rock with good flat surface 

Photo – scanned, adjusted for size, and printed on color 

laser printer.  

Acetone nail polish remover 

Cotton balls 

Piece of felt 

 

General Instructions: 

Scan a picture and insert into a Word or Publisher 

document.  If picture has writing or an obvious left-right direction in the picture be sure to Flip Horizontal 

(find on the Format tab under Rotate).  Print picture using color laser copier or printer.  

  

Put picture face down on rock.  Dab at back of picture with a cotton ball saturated with acetone.  

Thoroughly saturate paper and press down.  Hold the picture steady so it doesn’t smudge.  Lift up corner of 

the picture to see how it’s transferring and dab more if necessary.  Note: I find I really need to SATURATE 

the paper with the acetone.  I have even carefully poured a bit of acetone and then dabbed to push the toner 

onto the rock 

 

When picture has transferred to your satisfaction, let it dry.  Glue a piece of felt to the bottom of the rock.   

 

 

Tips: Don’t choose a picture that is too “busy.”  Make sure photo has good contrast.  Rock should have a 

good flat surface without crags and dents.   Rock should be light colored and not have a lot of obvious 

flecks of color on it. 
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Heritage Craft – Jar O’Questions and Book O’Answers 
Mary Kircher Roddy – www.mkrgenealogy.com 

 

 

Photo by Mark Roddy 

 

Supplies for project:  
Glass jar 

Journal (composition books work well for this) 

Scrapbooking paper 

Mod Podge 

Cardstock 

 

Tools for Project: 

Scissors and/or paper cutter 

 

General Instructions: 

Decorate your journal.  I glued on scrapbook paper and a label I created. 

Decorate your jar.  Use paint, stickers, acid etching compound, fabric, scrapbook paper or anything that suits 

your taste. 

 

Fill jar with strips of paper each containing a story prompt. Plain paper is fine or print on blank side of 

scrapbook paper  

 

Ideas for where to find story prompts: 

500 Prompts for Narrative and Personal Writing -  http://learning.blogs.nytimes.com/2014/11/13/500-

prompts-for-narrative-and-personal-writing/?_r=0 

 

Journal Writing Prompts for Life Story Writers - http://www.familyhistoryproducts.com/journal-writing-

prompts.html 

 

52 Questions in 52 Weeks - https://familysearch.org/blog/en/52-questions-52-weeks/ 

 

Oral History Interview Question Lists - http://familytreemagazine.com/article/Oral-History-Interview-

Question-Lists 

http://learning.blogs.nytimes.com/2014/11/13/500-prompts-for-narrative-and-personal-writing/?_r=0
http://learning.blogs.nytimes.com/2014/11/13/500-prompts-for-narrative-and-personal-writing/?_r=0
http://www.familyhistoryproducts.com/journal-writing-prompts.html
http://www.familyhistoryproducts.com/journal-writing-prompts.html
https://familysearch.org/blog/en/52-questions-52-weeks/
http://familytreemagazine.com/article/Oral-History-Interview-Question-Lists
http://familytreemagazine.com/article/Oral-History-Interview-Question-Lists
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Heritage Craft – Glass Slide Ornaments 
Mary Kircher Roddy – www.mkrgenealogy.com 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Please read supply list and instructions a 
couple of times through before you start 
project.  There are a lot number of steps. 
 
Supplies for project: 
Photos printed on thin paper (see below) 
Glass microscope slides – clear glass (.8mm-
1.0mm thick, 1x3” or 2x3”)1  
Copper foil tape - 7/32”2 
Flux3 
Solder4 
Silver-tone craft wire 20 gauge 
Ribbon for hanging 

Tools for Project: 
Computer with software to manipulate scans (eg 
Microsoft Publisher) 
Printer 
Scissors or paper cutter 
Soldering iron5 
Jewelry wire cutter 
Bic-type pen or popsicle stick for burnishing 

Bic-type pen, knitting needle or dowel for 
forming jump rings 
Q-tips  
Glass cleaner & paper towels 
Protective surface like a granite tile  
 
General Instructions: 
The pre-preparation involves printing pictures to 
the appropriate sizes.  You can use whatever 
kind of printer you want – inkjet, laser, or color 
laser printer like they have at Kinko’s.   
Microscope slides come in 2 sizes - 1” x 3” and 
2” x 3”  Attached is a Microsoft publisher 
document which has several sample sizes of 
these ornaments.  Find a picture, crop out what 
you want and size it to the appropriate size.  
Print them on regular paper, not photo paper.  
(You don’t want the paper to be too thick.) 
The 1”x3” ornaments work well in vertical 
format.  They are great for a standing person or 
a couple who are close to each other.  They 
make a really nice ornament.  The 2”x3” 
ornament can work in vertical or horizontal 
format.  They are great for group pictures.   
Crop your pictures and print a page full of 
pictures to make ornaments out of.  Cut them to 
size (better just a hair under the stated size) 
 
Take 2 photos of the same size and orientation 
and put them back to back.   Sandwich the pair 
of photos between two microscope slides.  Try 
to handle the glass slides by the edges so you 
don’t get fingerprints on the insides (picture 
side) of the 
glass.
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The copper tape has one side of copper and one 
side of sticky.  Wrap the edges of the glass slide 
sandwich with the copper tape.  I start and end 
the copper tape at the top center where I will 
eventually solder the hanging ring. Overlap the 
copper tape just a hair, maybe 1/8” or so.  You 
don’t want to start your copper tape at a corner 
because you won’t get a good result on that 
corner.

 
 
Fold down copper tape onto fronts of the slides, 
forming “hospital corners.”  Burnish the copper 
tape down using the  side of Bic pen or a 

popsicle stick.  I use the Bic pen, not a metal 
pen, because I want something that is solid but 
has a bit of give (less 
broken glass that way.)  

Don’t do this on hard surface like a wood table 
– use paperback book or magazine, which like 
the Bic pen has a bit of give.  Make sure the 
tape is well stuck to the glass.  If there are gaps, 
your solder and flux will leak in between the 
slides and discolor your photos.  Also, if the 
tape is not well adhered to the glass, it might 
peel off the glass later. 
 
Spread flux on copper tape using Qtip.  It’s OK 

if a bit 
gets on 
the 
glass 
because 
the 
solder 
only 
sticks to 
the 

copper, not to the glass.  The purpose of the flux 
is to make the solder flow along the metal, so 
put a thin, even coat of flux on all 3 edges of the 
metal.   
 
Do the next steps over the granite tile.  The 
soldering iron is hot, and with the flux and 
solder this can be a bit messy.  If you are using 

lead solder, you 
don’t want to 
use your crafting 
work surface for 
food prep, so 
having a 
separate granite 
tile devoted to 
crafting is a 
good idea. 
 

Run solder over copper tape.  Be careful, the tip 
of the soldering iron is VERY HOT!  I work my 
way around the edge – top, side, bottom, side, 
then the front – top, side, bottom, side, then the 
back– top, side, bottom, side.  The soldering 
iron is like a pen and you are just drawing down 
the edges.   Before burnishing - edges not 

well adhered 

After burnishing - 
see how flat copper 
tape looks 
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Wrap wire into coil around pen to make wire 
jump rings.  Cut rings apart with wire cutter.   
 
Lay the ornament flat on the granite.  Put a glass 

slide next to the place 
where you will solder 
the ring and place the 
ring on it so the joint in 
the ring touches the 
ornament (the glass slide 
will lift up the ring so it 
will be centered).  
Solder wire loop onto 
top edge of ornament 

with where the wires meet touching the 
ornament so the solder 
will fill in the gap. 
 
Clean ornament with 
paper towel and window 
cleaner. The flux will 
have left a bit of greasy 
residue on the glass. Be 
careful not to get too 
much window cleaner 
on glass because it 
might bleed under the 
solder and tape and 
damage your picture.  
 
  
 
Attach ribbon for hanging. 
 
WARNINGS: 
General – heed all instructions and warning 
labels on the products you use.  
 
Soldering irons are very hot.  They can burn 
you.  I have the scars to prove it. 
 
Solder can be toxic.  Many solders have lead in 
them.  Try not to inhale the hot gases when 
flowing the solder along the copper tape.  You 
can also find solder that has no lead.  If you use 

lead solder, wash your hands well after touching 
the solder (or the edges of the ornament that 
have been soldered) and before touching food. 
  
 
                                                 
1 Glass slides – you may find small(ish) packages of these 
at a craft store like Michael’s.  For larger quantities, 
generally in boxes of 72 or 100 try the internet for science 
supply companies or Amazon.  Gorillascientific.com sells 
a box of 72 2x3” slides for $10 (as of 5/26/15)  
2 You can find this at a stained glass supply store or 
online 
3 Stained glass supply store or online 
4 Stained glass supply store or online.  Unleaded solders 
behave slightly differently than leaded solders when you 
are working them.  As they age, the patina that develops 
may be different from one type to another.  For small 
projects like these ornaments, this doesn’t bother me, but 
it is a matter of personal choice. 
5 Available at craft stores, hobby stores, and hardware 
stores. 

Hanging ring resting 
on scrap piece of slide 
to bring it up to proper 
level for soldering 
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Heritage Craft – Travertine Tile Ornament or Coaster 
Mary Kircher Roddy – www.mkrgenealogy.com 

 

Supplies for project: 
Photos to scan 
Travertine tiles (see notes below)  
Golden Gel medium 
Ribbon (for ornament) 
20-gauge craft wire (for ornament) 
Felt or sheet cork (for coaster) 
Mod Podge (for coaster) 
 
Tools for Project: 
Foam paint brush 
Scissors 
Old spoon 
Wire cutters (for ornament) – optional 
Scanner 
Thumb drive 
Hot glue gun 
 
Notes on Tiles: 
Travertine tiles are available in tile shops and 
home improvement centers which carry tiles. 
 
Tiles come in 4x4” size, and usually can be 
bought singly.  The 4x4 tiles are good for 
coasters. 
Tiles also come in 2x2” size and 36 tiles are 
glued to a mesh background approximately 12” 
square. The 2x2 tiles are good for ornaments. 
 
General Instructions: 
Scan photos.   
 
In  a Word or Publisher document create square 
templates to hold the pictures.  Insert > Shapes, 
chose the square shape. Left click the mouse 

and drag to create a shape of the desired size. 
The size of the pictures you will print should be 
approximately ¼ to 3/8” smaller than the tile.  
The 2x2 tiles are slightly smaller than 2x2 so the 
square templates should be approximately 
1.75x1.75”.  The square template for the 4x4 tile 
should be about 3.75 x 3.75” 
 
Import your pictures into the square templates.  
If your photo has an obvious left-right direction, 
or if there are words in your image, you will 
need to flip the image horizontally to get the 
mirror image (find on the Format tab under 
Rotate.)  When the project is completed, the 
image will face in the proper direction. 
 
For images I have used old family photos, either 
of people or perhaps houses.  I have also used 
holiday themed images either from websites or 
clip art packages.   
 
You can generally fit several images on one 
page.  Print images on a color laser printer or 
copier.  (Ink jet printers won’t work for this!!!) I 
generally save a page or two of images to a 
thumb drive/usb stick and then print at my local 
copy shop.  Most of them have color printers 
which will read from a thumb drive. 
 
Rinse tiles to remove the dust.  Let them dry. 

 
Cut the printed images to size.  Paint a layer of f 
gel medium onto the picture.  Try not to get any 
medium on the back of the paper.  Place the 
picture gel side down onto the front side of the 
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tile.  Rub the back of the paper using the back of 
the old spoon to adhere the picture to the tile. 
 
Let it dry thoroughly.  Let it dry some more.  
Let it dry even more.  Try to forget about the 
project.  You will be tempted to want to go on to 
the next step, but resist the urge for 48 hours at 
least.  I find I get a much better transfer with a 
looong dry time. 
 
Once the pictures/gel are thoroughly dry, trim 
the paper as close to the glass as you can with 
scissors.  Soak the dried glass-paper thing in a 
dish of water.  Soon you will see the paper get 
soaked and you’ll be able to see the image 
through the paper.  Use the fat part of your 
thumb to rub away the paper.  What happens is 
that the laser ink pigments get absorbed into the 
gel medium and you just need to rub to remove 
the paper.  It is a process of rubbing and then 
soaking a little more and then rubbing again to 
get more paper off.  Don’t scrape or you will 
scrape the gel medium right off the glass.  Just 
rub.  When it dries you may see more bits of 
paper, or a paper “haze.” If so, soak and rub a 

little more.  You might not get 100% but get as 
much as you can, and call it good. 
 
Finishing: 
For coaster, cover with 2-3 coats of decoupage 
medium to protect surface.  Let dry thoroughly 
before using. Glue felt or sheet cork to 
underside to protect table surface when using 
the coaster. 
 
For ornament, cut a 3” length of wire. Create a 
hanging loop in the center and twist the ends 
into flat coils (to provide more glue surface 
area.)  See illustration below.  Using hot glue 
gun, glue hanger to back of ornament.  Cut a 
piece of felt to size and glue to back of 
ornament.  Thread a piece of ribbon through 
wire loop to hang ornament. 
 
 
 
 
 
 

 
 
 

Hanging loop 

Glue this area 
to back of 
ornament with 
hot glue gun 


